
 

User guide Please read the sections “Important notice” and “Warnings” at the end of this document Revision 1.0 

www.infineon.com  2024-04-08 

 

  

 
UG091835 

Infineon Mobile Robot (IMR) battery 

management control 

Using DEMO_IMR_BMSCTRL_V1 

About this document 

Scope and purpose 

This document provides a comprehensive functional description and guide for the DEMO_IMR_BMSCTRL_V1 
demonstration board. Hardware is shown and explained in detail with software to be updated as soon as 

available. Furthermore, a basic quick start guide is provided for the intended use as the Infineon mobile robot 
(IMR) BMS controller.  

Intended audience 

This document is intended for design engineers, technicians, and developers of electronic systems. 

Infineon components featured 

• OptiMOS™ BSD235N 2 small-signal transistor 

• IRLML6401 Single P-channel power MOSFET  

• PSoC™ 6 CY8C6245AZI-S3D72, 32-bit dual-CPU microcontroller with Arm® Cortex®-M4F and M0+ 

• CY15B256Q-SXA 256 Kb automotive serial (SPI) F-RAM  

http://www.infineon.com/
https://www.infineon.com/cms/de/product/power/mosfet/small-signal-small-power/bsd235n/
https://www.infineon.com/cms/en/product/power/mosfet/p-channel/irlml6401/
https://www.infineon.com/cms/en/product/microcontroller/32-bit-psoc-arm-cortex-microcontroller/psoc-6-32-bit-arm-cortex-m4-mcu/cy8c6245azi-s3d72/
https://www.infineon.com/cms/en/product/memories/f-ram-ferroelectric-ram/cy15b256q-sxa/
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Important notice 

“Evaluation Boards and Reference Boards” shall mean products embedded on a printed circuit board 

(PCB) for demonstration and/or evaluation purposes, which include, without limitation, demonstration, 
reference and evaluation boards, kits and design (collectively referred to as “Reference Board”).  

 
Environmental conditions have been considered in the design of the Evaluation Boards and Reference 
Boards provided by Infineon Technologies. The design of the Evaluation Boards and Reference Boards 
has been tested by Infineon Technologies only as described in this document. The design is not qualified 

in terms of safety requirements, manufacturing, and operation over the entire operating temperature 
range or lifetime. 

 
The Evaluation Boards and Reference Boards provided by Infineon Technologies are subject to functional 

testing only under typical load conditions. Evaluation Boards and Reference Boards are not subject to the 
same procedures as regular products regarding returned material analysis (RMA), process change 
notification (PCN) and product discontinuation (PD). 

 

Evaluation Boards and Reference Boards are not commercialized products, and are solely intended for 

evaluation and testing purposes. In particular, they shall not be used for reliability testing or production. 

The Evaluation Boards and Reference Boards may therefore not comply with CE or similar standards 
(including but not limited to the EMC Directive 2004/EC/108 and the EMC Act) and may not fulfill other 
requirements of the country in which they are operated by the customer. The customer shall ensure that 

all Evaluation Boards and Reference Boards will be handled in a way, which is compliant with the 
relevant requirements and standards of the country in which they are operated. 

 

The Evaluation Boards and Reference Boards as well as the information provided in this document are 
addressed only to qualified and skilled technical staff, for laboratory usage, and shall be used and 

managed according to the terms and conditions set forth in this document and in other related 
documentation supplied with the respective Evaluation Board or Reference Board.  
 
It is the responsibility of the customer’s technical departments to evaluate the suitability of the 

Evaluation Boards and Reference Boards for the intended application, and to evaluate the completeness 
and correctness of the information provided in this document with respect to such application. 
 
The customer is obliged to ensure that the use of the Evaluation Boards and Reference Boards does not 
cause any harm to persons or third-party property.  

The Evaluation Boards and Reference Boards and any information in this document is provided "as is" 

and Infineon Technologies disclaims any warranties, express or implied, including but not limited to 

warranties of noninfringement of third-party rights and implied warranties of fitness for any purpose, or 
for merchantability.  

 
Infineon Technologies shall not be responsible for any damages resulting from the use of the Evaluation 
Boards and Reference Boards and/or from any information provided in this document. The customer is 

obliged to defend, indemnify, and hold Infineon Technologies harmless from and against any claims or 
damages arising out of or resulting from any use thereof. 

 
Infineon Technologies reserves the right to modify this document and/or any information provided 
herein at any time without further notice. 
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Safety precautions 

Note: Please note the following warnings regarding the hazards associated with development systems. 

Table 1 Safety precautions 

 

Warning: The DC link potential of this board is up to 1000 VDC. When measuring 
voltage waveforms by oscilloscope, high-voltage differential probes must be used. 

Failure to do so may result in personal injury or death. 

 

Warning: The evaluation or reference board contains DC bus capacitors, which take 

time to discharge after removal of the main supply. Before working on the drive 
system, wait 5 minutes for capacitors to discharge to safe voltage levels. Failure to do 

so may result in personal injury or death. Darkened display LEDs are not an indication 

that capacitors have discharged to safe voltage levels. 

 

Warning: The evaluation or reference board is connected to the grid input during 

testing. Hence, high-voltage differential probes must be used when measuring voltage 

waveforms by an oscilloscope. Failure to do so may result in personal injury or death. 

Darkened display LEDs are not an indication that capacitors have discharged to safe 

voltage levels. 

 

Warning: Remove or disconnect power from the drive before you disconnect or 

reconnect wires, or perform maintenance work. Wait five minutes after removing 
power to discharge the bus capacitors. Do not attempt to service the drive until the bus 
capacitors have discharged to zero. Failure to do so may result in personal injury or 

death. 

 

Caution: The heat sink and device surfaces of the evaluation or reference board may 
become hot during testing. Hence, necessary precautions are required while handling 

the board. Failure to comply may cause injury. 

 

Caution: Only personnel familiar with the drive, power electronics and associated 
machinery should plan, install, commission and subsequently service the system. 

Failure to comply may result in personal injury and/or equipment damage. 

 

Caution: The evaluation or reference board contains parts and assemblies sensitive to 

electrostatic discharge (ESD). Electrostatic control precautions are required when 

installing, testing, servicing or repairing the assembly. Component damage may result 

if ESD control procedures are not followed. If you are not familiar with electrostatic 

control procedures, refer to the applicable ESD protection handbooks and guidelines. 

 

Caution: A drive that is incorrectly applied or installed can lead to component damage 

or reduction in product lifetime. Wiring or application errors such as undersizing the 
motor, supplying an incorrect or inadequate AC supply, or excessive ambient 

temperatures may result in system malfunction. 

 

Caution: The evaluation or reference board is shipped with packing materials that 
need to be removed prior to installation. Failure to remove all packing materials that 

are unnecessary for system installation may result in overheating or abnormal 

operating conditions. 
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1 Introduction 

1.1 Mobile robot general description 

Mobile robots are now common in applications from logistics and warehouse centers and production sites to 
hospitals, restaurants, and schools, and as last-mile package delivery vehicles. On a high level, mobile robots 
are of two main types: 

• Automated guided vehicles (AGV): "Fixed” vehicles that follow predefined paths using lasers, barcodes, 
radio waves, vision sensors, or magnetic tape for navigation. 

• Autonomous mobile robots (AMR): Not “fixed”, and do not need external paths as these use autonomous 

mapping, localization, navigation, and obstacle avoidance by using sensors.  

Usually, robots are battery-powered where the voltage level depends on the size and weight characteristics.  

1.2 Infineon Mobile Robot (IMR)  

The board described in this document is primarily targeted to be used in combination with the Infineon Mobile 
Robot (IMR). The IMR is a comprehensive robotic platform for use with a wide variety of boards such as sensors, 
motor controls, wireless communication, and battery management.  

 

Figure 1 Infineon Mobile Robot (IMR): Isometric view  

The IMR is intended to provide a demonstration platform for autonomous service robot functionalities by using 
Infineon components. This document describes how to use the DEMO_IMR_BMSCTRL_V1 board as the 
processing unit for all battery management system (BMS) tasks and interface the BMS power board including 

the following: 
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• Battery monitoring 

• Battery balancing 

• Estimation of state of charge (SoC) 

• Estimation of state of health (SoH)  

 

Figure 2 IMR overview: DEMO_IMR_BMSCTRL_V1 board highlighted in red. Two BMS modules are 

installed in the IMR to facilitate hot swap and increase the overall capacity.  

1.3 DEMO_IMR_BMSCTRL_V1 demo board  

The DEMO_IMR_BMSCTRL_V1 board is a modular battery management solution, specifically designed to work 
with the battery-driven power board for the IMR. The board features a PSoC™ 6 series Arm® Cortex®-M4/M0+ 

MCU performing all necessary tasks including measurements and calculations. It estimates the battery’s state 
of charge (SoC) and state of health (SoH) using measured voltages and currents and display the calculated 
values on the provided ePaper display.  

After combining the board with an appropriate IMR battery power board (i.e., DEMO_IMR_BMSPWR_V1), the 
complete system is installed vertically into one of the IMR’s battery management slots. After installation, all 

necessary communication is handled via the CAN/CAN FD interface. The board’s unique CAN identifier can be 

set using the onboard DIP switch. 
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Figure 3 DEMO_IMR_BMSCTRL_V1 board top (left) and bottom (right) view (80 mm x 80 mm) 

1.4 Connectors 

The DEMO_IMR_BMSCTRL_V1 board provides connectors to support several peripherals, communication 
protocols, and connections to control the IMR battery power board (DEMO_IMR_BMSPWR_V1). This includes 

analog, digital, and communication lines for the following: 

• Two external BMS buttons 

• Four external status LEDs 

• SPI serial interface and chip-select lines for two peripherals 

• CAN communication lines for an external CAN transceiver 

• UART debugging interface 

• UART interface for the TLE9012 cell balancing IC 

• Additional digital/analog lines for further functionality 

In addition to the onboard ePaper display, an additional connector featuring both SPI and I2C interface is 
available for other displays (e.g., SSD1306). The following schematic shows the four main communication 

connectors and the debug communication header. 



  

User guide 8 Revision 1.0 

  2024-04-08 

 

Infineon Mobile Robot (IMR) battery management control 
Using DEMO_IMR_BMSCTRL_V1 

  

Introduction 

 

Figure 4 COM_CommunicationPort.SchDoc - Schematic overview of peripheral connectors 

Table 1 shows the connection between connector P1 and the corresponding PSoC™ 6 MCU pins (UART 

transmit/receive lines) for the UART debugging interface. See the Quick start guide section for details of how to 
use this connector. 

Table 2 Connection between connector P1 and PSoC™ 6 MCU for UART debugging interface 

Name PSoC™ 6 MCU pin Function Description 

DEBUG_UART_TX P0.3 Serial debug output UART transmit line 

DEBUG_UART_RX P0.2 Serial debug input UART receive line 

Table 2 shows the common GND connector (X1) closest to the 40-pin FPC e-display connector; it is therefore 
chosen without any additional communication lines. 

Table 3 Connector X1 – Common GND connection 

Name PSoC™ 6 MCU pin Function Description 

GND – Signal ground – 

Table 3 shows the connection between connector X2 and the corresponding PSoC™ 6 MCU pins for LEDs and 
buttons control. Additionally, both 5 V and 3.3 V are placed on the connector to supply any microcontrollers. 
The V_MCU line is used to set the digital supply voltage for peripherals on externally connected boards (the 

BMS power board in this case). The selected voltage for the PSoC™ 6 MCU is 3.3 V; V_MCU is also routed to that 

voltage level. The 5 V supply is unused. 
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Table 4 Connection between connector X2 and PSoC™ 6 MCU for BMS control/indicator and power 
connection 

Name PSoC™ 6 MCU pin Function Description 

5 V – Signal power input 5 V DC power input 

V_MCU – Signal power output Peripheral power 

selector (selected: 3V3) 

3V3 – Signal power input 3.3 V DC power input 

GND – Signal ground – 

BMS_BUTTON1 P7.1 Digital input/ERU Digital ERU button input 

BMS_BUTTON2 P7.0 Digital input/ERU Digital ERU button input 

BMS_LED_A P10.5 Digital output Digital status LED output 

BMS_LED_B P7.7 Digital output Digital status LED output 

BMS_LED_C P7.6 Digital output Digital status LED output 

BMS_LED_D P7.5 Digital output Digital status LED output 

Table 4 shows the connection between connector X3 and the corresponding PSoC™ 6 MCU pins for SPI and CAN 
serial interface lines. Additionally, this connector has an analog input that lets the system detect the hardware 

that the BMS is currently inserted in. The SPI interface has two Chip Select (CS) lines, which are currently used 
communication with the following: 

•  2ED4820 high-side gate driver 

• 16-bit ADC for current and load voltage measurements 

Table 5 Connection between connector X3 and PSoC™ 6 MCU for the serial communication  

Name PSoC™ 6 MCU pin Function Description 

SPI_ MOSI P11.0 SPI MOSI SPI master out; slave in 

SPI_ MISO P11.1 SPI MISO SPI master in; slave out 

SPI_ SCLK P11.2 SPI SCLK SPI clock 

SPI_ CS_2ED4820 P11.4 SPI Chip Select SPI 2ED4820 Chip Select 

SPI_ CS_16B_ADC P11.3 SPI Chip Select SPI MCP3465 Chip Select 

GND – Signal ground – 

Coding_Res P10.7 Analog input Analog slot detection 

CAN_TXD P5.1 CAN output CAN transmit line 

CAN_RXD P5.0 CAN input CAN receive line 

CAN_STB P5.6 Digital output Optional CAN standby 

Table 5 shows the connection between connector X4 and the corresponding PSoC™ 6 MCU pins for serial 
communication lines to the following external components on IMR battery power board: 

• Main UART communication interface for the TLE9012 battery balancing IC 

• Auxiliary digital and analog inputs/outputs for the TLE4971 current sensor and 2ED4820 high-side gate 
driver 

 

https://www.infineon.com/cms/en/product/battery-management-ics/tle9012dqu/
https://www.infineon.com/cms/en/product/sensor/current-sensors/tle4971-a120n5-e0001/
https://www.infineon.com/cms/en/product/power/gate-driver-ics/automotive-gate-driver-ics/2ed4820-em/
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Table 6 Connection between connector X4 and PSoC™ 6 MCU for the serial communication and 
auxiliary inputs/outputs 

Name PSoC™ 6 MCU pin Function Description 

TLE9012_UART_HS P6.0 UART HS UART TLE9012 HS line  

TLE9012_UART_LS P6.1 UART LS UART TLE9012 LS line 

TLE9012_ERR P6.5 Digital input TLE9012 error output 

SD_N_MCU P8.3 Digital output Power Stay-on output 

TLE4971_OCD1 P8.0 Digital input TLE4971 over-current 

detection output 1 

TLE4971_OCD2 P8.1 Digital input TLE4971 over-current 

detection output 2 

2ED4820_SAFESTATEN P7.2 Digital output 2ED4820 safe state 

enable output 

2ED4820_ENABLE P7.4 Digital output 2ED4820 enable output 

2ED4820_INTERRUPT P7.3 Digital input 2ED4820 error flag 

output 

2ED4820_CSO P10.6 Analog input 2ED4820 current analog 

output 

In addition to the ePaper display on the board, an additional optional connector (J2) supports an external I2C 
or SPI TFT display (e.g., SSD1306). The connector is supplied via the 3V3 voltage supplied input. 

 

Figure 5 COM_CommunicationPort.SchDoc – Optional TFT connector  
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Table 7 Connection between connector J2 and PSoC™ 6 MCU – Optional TFT connector for I2C 
display (e.g., SSD1306) 

Function PSoC™ 6 MCU pin Function Description 

GND – Signal ground – 

3V3 – Signal power Regulated 3.3 V DC 

supply 

SPI_EPD_MOSI P9.0 SPI MOSI SPI MOSI/I2C SCL 

SPI_EPD_MISO P9.1 SPI MISO SPI MISO/I2C SDA 

EPD_RST_L P10.4 Digital output OLED Reset (RST) 

EPD_VCC_EN P12.0 Digital output OLED Data Comm. (DC) 

SPI_EPD_CS P9.3 SPI CS OLED Chip Select (CS) 
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2 Hardware 

This chapter describes the most important functional parts of the board hardware. See the Appendix for full 

schematics, including microcontroller schematics and overview. 

2.1 Piezo-electric buzzer circuit 

To provide audio feedback, a Piezo-electric sounder and necessary auxiliary components are provided. This 
provides audio feedback on the following events:  

• End of charging 

• Low-voltage warning 

• Overcurrent warning 

• Overtemperature warning 

The speaker can be controlled using one of the PSoC™ 6 MCU’s digital outputs. 

 

Figure 6 Piezo-electric buzzer circuitry including auxiliary components 

2.2 Serial F-RAM memory circuit 

The CY15B256Q 256 Kb nonvolatile memory based on an advanced ferroelectric process performs reads and 
writes similar to a RAM. It provides reliable data retention for 121 years while eliminating the complexities, 

overhead, and system-level reliability problems of serial flash, EEPROM, and other nonvolatile memories. 

Unlike serial flash and EEPROM, CY15B256Q performs write operations at bus speed without write delays. Data 
is written to the memory array immediately after each byte is successfully transferred to the device [1].  

In this application, the CY15B256Q device is used to store the measured individual cell voltages and overall 

current values for further calculation of SoC and estimation of SoH. The chip provides an SPI interface, which is 
directly connected to one of the PSoC™ 6 MCU’s peripheral SPI blocks. In addition to the common lines for SPI 
communication, additional pins are provided:  

• Write Protect (WP) pin: Input that prevents write operations; can be used to prevent unwanted changes to 

the Status Register 

• HOLD pin: Input and can be used by the host CPU to determine if it must interrupt a memory operation for 
another task temporarily 

https://www.infineon.com/dgdl/Infineon-CY15B256Q_256-KBIT_32K_X_8_AUTOMOTIVE-E_SERIAL_SPI_F-RAM-DataSheet-v01_00-EN.pdf?fileId=8ac78c8c7e7124d1017f1bf9a5ff15a4
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Figure 7 CY15B256Q automotive serial F-RAM circuit (256 Kb) interfaced via SPI 

2.3 ePaper display circuitry 

The board has an ePaper display to display all necessary information and BMS status, including the last BMS 
state even when the system is powered off. The display is powered up directly from the microcontroller via 

IRLML6401 P-channel MOSFET. Necessary discharge lines are driven via the BSD235 dual-package switch. The 
connector is a 40-pin FPC connected to various auxiliary components. As a reference, the E-ink Display Shield 
Board (CY8CKIT-028-EPD) is used for auxiliary components and communication lines. 

 

Figure 8 ePaper display connector circuit with auxiliary components (for Pervasive Displays 

E2200CS021) 

https://www.infineon.com/cms/en/product/power/mosfet/p-channel/irlml6401/
https://www.infineon.com/dgdl/Infineon-BSD235C-DS-v02_04-EN.pdf?fileId=db3a30433580b371013585a2d0d53326
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2.4 CAN unique identification circuit 

To identify each board interfaced via CAN bus uniquely, a DIP switch is implemented. Each pin is pulled up via a 

20 k resistor and therefore provides an inverted logic that must be considered when reading the pin via the 
PSoC™ 6 MCU. 

 

Figure 9 CAN node identification circuit including 8-pin DIP switch 

Each switch is connected to a CAN_ID pin of the PSoC™ 6 MCU to individually set up to 255 devices on the same 
CAN/CAN FD bus. Table 8 shows each DIP switch pin and the corresponding PSoC™ 6 MCU pin for reference, as 
well as the decimal value assigned to the pin. When pulled up to 3.3 V, the pins follow an inverted logic: the OFF 

state on the DIP switch represents a logic HIGH on the PSoC™ 6 MCU pin and vice versa. 

Table 8 DIP Switch S1 – CAN node identifier logic and pin assignment 

CAN ID bit ID10 ID9 ID8 ID7 ID6 ID5 ID4 ID3 ID2 ID1 ID0 

DIP switch N/A N/A N/A Pin 8 

(MSB) 

7 6 5 4 3 2 Pin 1 

(LSB) 

PSoC™ 6 MCU 

pin 

– – – P3.1 P3.0 P2.7 P2.6 P2.1 P2.0 P0.5 P0.4 

BMS control 

CAN ID 

0 0 0 0 0 1 1 1 1 0 BMS[0] 
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3 Firmware 

This section introduces the environment of PSoC™ MCUs and the software interfaces used for communication 

with the BMS. 

3.1 PSoC™ MCU 

The PSoC™ 6 family is built on an ultra-low-power architecture and the MCUs feature low-power design 
techniques that are ideal for battery-powered applications. The dual-core Arm® Cortex®-M4 and Cortex®-M0+ 

architecture lets designers optimize for power and performance simultaneously. Using its dual cores combined 

with configurable memory and peripheral protection units, the PSoC™ 6 MCU delivers the highest level of 
protection defined by the Platform Security Architecture (PSA) from Arm® [2]. 

The CY8C6245AZI-S3D72 device in a 100-pin TQFP100 package supports both a 150 MHz Cortex®-M4F and a 
100 MHz Cortex®-M0+ and has 512 KB application flash and 256 KB of SRAM. This device provides 
programmable power control inside the largest available package with the most I/O pins available for this 

device family. 

 

Figure 10 CY8C6245AZI-S3D72 PSoC™ 6 TQFP 100-pin configuration (top view) [2] 

3.2 Firmware description and flowcharts 

Will be updated in further versions. 

 

 

 

 

https://www.infineon.com/cms/en/product/microcontroller/32-bit-psoc-arm-cortex-microcontroller/psoc-6-32-bit-arm-cortex-m4-mcu/cy8c6245azi-s3d72/
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3.2.1 CAN message structure 

Each CAN message follows the standardized CAN protocol (see Figure 11). In general, each message consists of 
a unique identifier describing the recipient (11 bits) followed by the data bytes (0 – 64 bits). Bits such as Start of 
Frame, stuff bits, Data Length Code (DLC), and checksums are included [3]. 

 

Figure 11 CAN bus frame, including stuff bits, correct CRC, and inter-frame spacing [3] 

In the case of the CAN identifier (Arbitration), only 8 bits are used in the IMR to specify the type and specific 
number of the board (ID0 to ID7). The remaining 3 bits (ID8 to ID10) remain on their original level (logic LOW). 

For the data frames, Byte 1 always corresponds to the byte that is transmitted/received first, followed by the 
other bytes from the same CAN transmission. To distinguish between different hardware on the IMR, each type 
of board is classified via a specific CAN ID range and therefore reserving a certain address region. Depending on 

the type of board, specific CAN ID bits can be set differently to differentiate boards from the same type. 

A total of eight data bytes can be transmitted in a single CAN message. The CAN communication setup on the 

IMR consists of a single byte containing the target command, followed by the CAN message sender ID (1 byte), 

and then up to of six data bytes—see the following table.  

Table 9 IMR CAN message data structure overview 

 Byte 1 Byte 2 Byte 3 Byte 4 Byte 5 Byte 6 Byte 7 Byte 8 

CAN message Command Sender ID Data[6:0] 

Table 9 shows the CAN messages to and from the DEMO_IMR_BMSCTRL_V1 board with their respective 
command bytes. The commands are currently reserved for their future purpose. 

Table 10 IMR BMS CAN message command overview 

 Byte 1 Byte 2 Byte 3 Byte 4 Byte 5 Byte 6 Byte 7 Byte 8 Description 

Reserved 0xB0 Sender 

ID 

N/A N/A N/A N/A N/A N/A Reserved 

Reserved 0xB1 Sender 

ID 

N/A N/A N/A N/A N/A N/A Reserved 

Reserved 0xB2 Sender 

ID 

N/A N/A N/A N/A N/A N/A Reserved 

Reserved 0xB3 Sender 

ID 

N/A N/A N/A N/A N/A N/A Reserved 
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4 Quick start guide 

This section helps you get started with using the board as a battery management module for the Infineon 

Mobile Robot. Later chapters describe how to program and debug the hardware, and set up the hardware for 
CAN communication. These sections also describe the relevant buttons, LEDs, and interfaces. 

4.1 Software deployment and debugging 

The firmware controlling this demo board is developed using ModusToolbox™ Software, a collection of easy-to-
use libraries and tools enabling rapid development with Infineon MCUs. Programming and debugging are 

carried out via the MiniProg4 program and debug kit (CY8CKIT-005). The DEMO_IMR_BMSCTR,L_V1 board is 
connected to the debug probe using the smaller 1.27 mm pitch ribbon cable and the 10-pin box header P2. 

Larger connector pins are used only if additional UART is necessary. The debug probe can be used both isolated 
(default) and non-isolated when using appropriate software such as CYPRESS™ Programmer. 

 

Figure 12 MiniProg4 Program and Debug Kit (CY8CKIT-005) 

The project is created within ModusToolbox™. This project contains the device definition, settings, and source 

files required to compile and build the executable code. You can then download the executable into the flash 

program memory of the PSoC™ 6 MCU.  

1. Select File > Import > General > Existing Projects into Workspace to import the ModusToolbox™ project. 

 

Figure 13 Eclipse IDE for ModusToolbox™ import window 

Note the project contents in the Project Explorer tab. Each CPU core owns its own sub-project inside the IDE 
with separate main.c files. 

https://www.infineon.com/modustoolbox
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Figure 14 IMR_SW_PSoC6_BatteryManagement – ModusToolbox™ project structure 

2. Use the Library Manager and Device Configurator links in the Quick Panel to configure the libraries and 
pin configurations.  

3. Select Build Application to compile the firmware. 

4. Select Generate Launches to apply the imported firmware to the board.  

5. Select the Debug option to program the firmware.  

The IDE shows the debug screen, where you can launch and debug the program. 

 

Figure 15 Eclipse IDE for ModusToolbox™  
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4.2 Debugging using onboard UART communication 

Additional debugging can be performed using the designated debugging header (P1) on the board. The header 
provides both RX and TX lines for standalone UART communication. The header can easily be interfaced using 
the MiniProg4 already used for flashing the board. The debugger provides all necessary pins (pins 6 and 8) to 
connect with the debugging header. 

 

Figure 16 UART debugging connector P1 interfaced using MiniProg4 

Use your favorite serial terminal (such as PuTTY or hterm) to read the received debugging messages. You can 

also use the built-in serial terminal (Window > Show View > Other… > Terminal > Terminal within the IDE). 

 

Figure 17 UART debugging connector P1 interfaced using MiniProg4 
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4.3 Setting the CAN node identification 

After flashing the board with the firmware, you need to set the board’s CAN node unique identification by using 
the 8-pin DIP switch S1. See the Hardware section. 

 

Figure 18 DIP switch to set unique CAN node ID for the board 

Example: This example describes the result of the following switch position on the CAN node identifier module. 

Table 11 DIP Switch S1 – CAN node identifier example 

DIP switch Pin 8 - 

MSB 

Pin 7 Pin 6 Pin 5 Pin 4 Pin 3 Pin 2 Pin 1 - 

LSB 

Switch position – – – – – – – OFF 

BMS[0] – – – – – – – 0 

This example DIP switch configuration sets the CAN node identifier for the DEMO_IMR_BMSCTRL_V1 board as 

60 (DEC) or 0x3C (HEX). This value is based on the board’s CAN mask (see Table 5) and the selected switches 

shown in the table above. This identifier helps other boards present to communicate with the 
DEMO_IMR_BMSCTRL_V1 board through CAN messages. 
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4.4 BMS control buttons and LEDs  

The board provides the following onboard buttons and LEDs (on the top of the system to be easily visible and 
reachable) to interface BMS functions without using onboard CAN communication.  

• Start: Long-press the button until the MCU Ready LED glows. This powers the system on and enables all 
functions.  

• Shutdown: Press this button to make the system disengage the output power supply and turn off the 
system completely when ready 

• Display: Display the next available page on the ePaper display 

 

 

Figure 19 Top view of IMR BMS controls and indicators 

The following LEDs are provided indicate the current system status:  

• MCU Ready: Indicates whether the system is currently powered. Press the Start button to display the 

current status: 

− LED ON: System powered on 

− LED blinking: Shutdown sequence active 

− LED OFF: System powered off 

• Output ON: Shows the status of the controlled system output. Indicates whether the system was able to 

turn on the output successfully: 

− LED ON: Output active 

− LED blinking: Pre-charge sequence active 

− LED OFF: Output not active 

• Warning: Indicates whether a system error is detected, such as pre-charge failure: 

− LED ON: System error detected 

− LED blinking: Not applicable 

− LED OFF: No system error 

• Status: Indicates the communication with the target system: 

− LED ON: Communication active 

− LED blinking: Not applicable  

− LED OFF: Communication not active 
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4.5 Charging and discharging using the BMS interfacing board 

This section describes how to charge and discharge the BMS system (BMS power board and BMS controller 
board). To interface the system, the BMS motherboard (DEMO_IMR_BMS_MOBO_V1) with the corresponding 
onboard resistor settings must be set.  

 

Figure 20 DEMO_IMR_BMS_MOBO_L_V1 and DEMO_IMR_BMS_MOBO_R_V1 board in IMR 

To use the system as a standalone power supply solution for your application, the BMS motherboard must be 
configured with the resistor R1 = 10 kΩ. This allows the system to detect if the inserted slot is designed to 

charge or discharge the BMS. In the image below, both interface cards can be seen in the IMR in the discharging 

configuration. After inserting the system into the slot, it can be powered-on using the Start button; after a 
successful initialization, the IMR is powered up. 

 

Figure 21 Using the BMS as the IMR power supply (discharging) 
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To charge the BMS, you need to use an external charging unit in combination with the BMS motherboard (in 
this case with the resistor R1 = 0 Ω). You must ensure that the charging voltage and current are set according to 

the limits specified for Li-Ion batteries used.  

Do the following to charge the batteries: 

1. Insert the system into the slot. 

2. Press the Start button to power on. 

Wait for successful initialization. Charging starts.  

 

Figure 22 Recharging onboard batteries in the external charging unit (charging) 
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5 Bill of materials (BOM) 

Table 12 Bill of materials 

Designator Manufacturer Part Number Quantity Value/Rating 

C1, C13 Würth Elektronik 885012106031 2 10 µF/25 V/0603/20% 

C2, C3, C4, C18, 

C20, C31 

Würth Elektronik 885012206076 6 1 µF/25 V/0603/10% 

C5, C6, C7, C8, C9, 
C14, C17, C19, C33, 

C38 

Würth Elektronik 885012206071 10 100 nF/25 V/0603/10% 

C10 Würth Elektronik 885012107018 1 4.7 µF/25 V/0805/10% 

C11, C12 Würth Elektronik 885012006093 2 8.2 pF/100 V/0603/10% 

C15, C16 Würth Elektronik 885012006050 2 6.8 pF/50 V/0603/10% 

C21, C22, C27, C28, 

C29, C30, C32 

Würth Elektronik 885012106029 7 2.2 µF/16 V/0603/10% 

C23, C24, C25, C26, 

C34, C35, C36, C37 

Würth Elektronik 885012207079 8 2.2 µF/25 V/0805/10% 

C39 Würth Elektronik 885012206092 1 33 nF/50 V/0603/10% 

D1 Würth Elektronik 150060BS75000 1 Blue/470 nm 

D2 Würth Elektronik 150060GS75000 1 Green/525 nm 

D3 Würth Elektronik 150060RS75000 1 Red/625 nm 

D4 Nexperia PMEG3020ER 1 Low VF Schottky 30 V/2 A 

J1 Würth Elektronik 687140183722 1 WR-FPC SMT ZIF 40p 

Horizontal Low Profile 

J2 Würth Elektronik 61300711821 DNP WR-PHD 7p 2.54 mm 

L1, L2 Würth Elektronik 742792663 2 1k@100 MHz 100 mA 

LS1 Murata 416131160808 1 Piezo Buzzer 4 kHz 

P1 Würth Elektronik 61300211121 1 WR-PHD 2p 2.54 mm 

P2 Würth Elektronik 62701021621 1 WR-BHD 10p 1.27 mm 

Q1 Infineon 

Technologies 

BSD235N 1 OptiMOS™ Dual N-

Channel small-signal 

MOSFET 

Q2 Infineon 

Technologies 

IRLML6401 1 HEXFET™ P-Channel 

power MOSFET 

R1, R2, R3 Vishay CRCW06031K00FK 3 1k/100 mW/0603/1% 

R4, R5 Bourns CAT16A-2002F4LF 2 20k/63 mW/1206/1% 

R6, R7, R14, R15 Vishay CRCW060310K0FKEA 4 10k/100 mW/0603/1% 

R8 Vishay CRCW06032K10FK 1 2k1/100 mW/0603/1% 

R9, R10 Yageo RC0603FR-074K7L 2 4k7/100 mW/0603/1% 

R11 Vishay CRCW0603150RFK 1 150 R/100 mW/0603/1% 

R12, R13 Vishay CRCW060310R0FKEA 2 10 R/100 mW/0603/1% 

S1 Würth Elektronik 416131160808 1 WS-DISV 8p DIP Switch 
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Designator Manufacturer Part Number Quantity Value/Rating 

S2 Würth Elektronik 434121025816 1 WS-TASV Tact Switch 

S3 Würth Elektronik 430481031816 1 WS-TASV SMT Switch 

U1 Infineon 

Technologies 

CY8C6245AZI-S3D72 1 32-bit PSoC™ 6 Arm® 

Cortex®-M4/M0+ 

U2 Infineon 

Technologies 

CY15B256Q-SXA 1 256-Kbit (32K × 8) 

Automotive Serial F-RAM 

U3 Texas Instruments SN74LVC2G14DCKR 1 Dual Schmitt-Trigger 

Inverter 

X1, X2, X3, X4 Würth Elektronik 61302021121 4 WR-PHD Dual Row 20p 

2.54 mm 

Y1 Würth Elektronik 830108207309 1 24 MHz/8 pF/10 ppm 

Y2 Würth Elektronik 830105946101 1 32.768 kHz/7 pF/20 ppm 
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6 PCB layout 

 

Figure 23 DEMO_IMR_BMSCTRL_V1 board top view 

 

Figure 24 DEMO_IMR_BMSCTRL_V1 board first inner layer 
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Figure 25 DEMO_IMR_BMSCTRL_V1 board second inner layer 

 

Figure 26 DEMO_IMR_BMSCTRL_V1 board bottom side 
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7 Appendix 

7.1 Schematics 

 

Figure 27 DEMO_IMR_BMSCTRL_V1 – 02_Top_Level.SchDoc 
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Figure 28 DEMO_IMR_BMSCTRL_V1 – CAN_IDSelectorArray.SchDoc 



  

User guide 30 Revision 1.0 

  2024-04-08 

 

Infineon Mobile Robot (IMR) battery management control 
Using DEMO_IMR_BMSCTRL_V1 

  

Appendix 

 

Figure 29 DEMO_IMR_BMSCTRL_V1 – COM_CommunicationPort.SchDoc 
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Figure 30 DEMO_IMR_BMSCTRL_V1 – MCU_PSOC6_CY8C62.SchDoc 
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Figure 31 DEMO_IMR_BMSCTRL_V1 – MEM_CY15B256Q.SchDoc 
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Figure 32 DEMO_IMR_BMSCTRL_V1 – PROG_2x5Pin_1.27mm.SchDoc 
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Figure 33 DEMO_IMR_BMSCTRL_V1 – EPD_E2200CS021.SchDoc 
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Figure 34 DEMO_IMR_BMSCTRL_V1 – BUZZ_PiezoSounderCircuit.SchDocz 

7.2 Firmware 

Will be included in further versions. 
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